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1. Introduction 

The aim of ArcelorMittal is to provide the industry a valuable, user-friendly and state-of-the-art software to design a 
cost-effective steel sheet pile wall. 

The key objective of the design engineer is to choose the most cost-effective sheet pile solution considering the 
different aspects that influence the structure safety during its lifetime. 

Prosheet is a software that allows to model the common actions on a retaining wall in order to establish its 
equilibrium by deducing the necessary tip level and the internal forces generated internally in each sheet pile section. 
It allows to define, for example, the excavation level, the support conditions and the external loads applied on the soil 
or directly on the wall. 

Prosheet is integrated in a multi-modules software including Durability and Anchor modules. 

 
Prosheet proposes many interesting features as listed below: 

• All input data is shown on an interactive cross-section drawing updated in real-time. 
• The user may choose the project type as well as sheet pile that will be used for the calculation. 
• Two different calculation methods are proposed (Classical and Eurocode 7-1). 
• Seismic conditions may be considerated: Monobe-Okabe and Lancellota methods are available. 
• Water conditions may be defined by a water table level or by custom pore pressure diagrams. 
• Results may be exported to Durability or to HZM/AZ Stresses for further verifications. 
• Several “Scenarios” may be tested and compared in the same project. 
• ArcelorMittal catalogue containing all available sheet piles is integrated. 
• Imperial and metric unit systems are available. 
• Numerous input data controls are integrated in the software 

It is important to note that the user has to read and validate Disclaimer and liability clauses before launching the 
software. Prosheet may be launched in several languages, please choose the one that suits you best. 

Please, don’t hesitate to contact ArcelorMittal team by mail (sheetpiling@arcelormittal.com) for further information or 
questions. Don’t forget to visit ArcelorMittal website (sheetpiling.arcelormittal.com) to check the updates. 
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2. Generalities 

Prosheet proposes a user-friendly interface to define and check several sheet pile solutions. 

Calculation may be done by using two different methods: 

• Classical method 
• Eurocode 7-1 method 

Following chapters will show the different options that have been implemented in the software for each calculation 
method. 

2.1. Scenario management 

Prosheet allows multiple and independent calculations in the same project. Each independent calculation is called 
Scenario. The idea is to be able to compare several solutions for the same cross-section or the same project.  

 

 To create a new scenario 

 To edit scenario name 

  To move from one scenario to another 
 

Scenarios menu propose to: 

• Delete current scenario 
• Copy current scenario: create a new scenario with the same input data 

Each scenario is organized in several tabs, each one dedicated for one purpose: 

• Project: definition of the type of project, calculation method, partial factors and calculation step 
• Sheet pile: choice of the sheet pile section, earth support and support 
• Soil: definition of the soil on the front side and at the back side 
• Hydraulic: definition of water conditions (phreatic level or custom pore pressure diagram) 
• Loads: definition of the different loads applied on the soil or directly on the sheet pile wall 
• Seismic: definition of the seismic parameters (only available if seismic calculation is requested in Project tab) 
• Results: provide intermediate and final results for each calculated cases (Graphs, Table and Details tabs). 
• Scenario synthesis: summarize all main results of each scenario 

Following chapters will show the different options available in each tab.  

2.2. Unit systems 

The user can either work in metric units (SI system) or in imperial units. 

It’s possible to switch the unit system using the Units menu. 

 

2.3. ArcelorMittal catalogue 

The newest ArcelorMittal catalogue version is integrated. Hot rolled sheet piles Z-type and U-type are handled as well 
as HZM/AZ combinations. 
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3. Cross-section drawing 

All input data is shown permanently on the left part of the Prosheet window. The user can point the mouse on each 
element to highlight it and see all all parameters related. 

Zoom and pan on the drawing is available by using the mouse wheel and mouse left click. He can also save the 
drawing in .png format by right clicking on the drawing: 

• Save image as .png : it will save the cross-section image with no zoom at all 
• Save zoomed image as .png: it will save the cross-section image with the current zoom. 

 

The data displayed on the draw can be chosen in the cross-section drawing options, available by right clicking on the 
cross-section drawing and choosing “Options”. 

 

The available general options are: 

• Font enlargement: define the scale of the text that can be read on the cross-section drawing. 
• Arrow gap: define the frequency of arrows that can be seen on distributed loads, wave loads, Caquot loads 

and Boussinesq loads. 
• Loads wall ratio: define the ratio used to convert the forces of linear, distributed loads and anchoring 

supports on the load in meters on the drawing. Example: for a linear load of F = 500 kN/m² with a loads wall 
ratio = 100, the linear load will be drawn as 500/100 = 5 meters long. 
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• Loads soil ratio: define the ratio used to convert the forces of Caquot and Boussinesq loads in meters on the 
drawing. Example: for a Caquot load of q = 500 kN/m² with a loads soil ratio = 100, the Caquot load will be 
drawn as 500/100 = 5 meters high. 

• Loads hydraulic ratio: define the ratio used to convert the wave loads and the pore pressure in meters on 
the drawing. 

Display options allow the user to choose what he wants to see on the cross-section drawing. Every element that is 
displayed can be disabled to allow the user to have different images representing what he wants to see. 

 

4. Project tab 

The project tab is used to define general parameters of the project. 

 

4.1. Description 

A small description of the project can be typed here to be included on the print. 

4.2. Type of project 

Several types of projects are available: 

• Cantilever wall: any support is present except passive earth pressure 
• Anchored wall: an anchor will support the wall 
• Propped wall: a strut will support the wall 
• Anchor wall: anchor wall submitted to the anchor reaction 
• Head wall and anchor wall: head wall equilibrium provides anchor reaction which is applied on anchor wall. 

Distance between walls has to be defined before calculation. Soils and other conditions may be different for 
each wall.  
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4.3. Calculation method 

Two calculation methods are available: 

• Classical: this method aims to reach the wall equilibrium with no ponderation on actions but with possible 
global safety on passive earth pressure (Sf factor). No local standard are used in this method 

• Eurocode: this method consists on applying partial factors on characteristic values of actions and 
resistances to deduce theirs design values before reaching wall equilibrium. Different approaches are 
proposed with different partial safety factors. 

Please, refer to part B of this manual (technical manual) for further information about calculation methods. 

4.3.1. Global safety factor of the classical method 

Clicking on “Show factors”, a pop-up is open and allows the definition of the global safety factor applied on passive 
earth pressure (Sf,min): 

 

4.3.2. Eurocode method factors 

Different Eurocode standard approach may be used for the calculation. Custom option allows to define a new set of 
partial factors. 
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Different factors are listed and defined here below: 

• γpa,dst  partial factor applied on the active earth pressure (destabilizing) 
• γpa,stb  partial factor applied on the active earth pressure (stabilizing) 
• γpb  partial factor applied on the passive earth pressure  
• γpw,dst  partial factor applied on the water pressure (destabilizing) 
• γpw,stb  partial factor applied on the water pressure (stabilizing) 
• γw  partial factor applied on the wall weight  
• γactions, soil, G, stb  partial factor applied on the permanent loads applied on the soil (stabilizing) 
• γactions, soil, G, dst partial factor applied on the permanent loads applied on the soil (destabilizing) 
• γactions, soil, Q, stb partial factor applied on the transient loads applied on the soil (stabilizing) 
• γactions, soil, Q, dst partial factor applied on the transient loads applied on the soil (destabilizing) 
• γactions, wall, G, stb partial factor applied on the permanent loads applied on the wall (stabilizing) 
• γactions, wall, G, dst partial factor applied on the permanent loads applied on the wall (destabilizing) 
• γactions, wall, Q, stb partial factor applied on the transient loads applied on the wall (stabilizing) 
• γactions, wall, Q, dst partial factor applied on the transient loads applied on the wall (destabilizing) 
• γQ  partial factor applied on the transient loads applied on the soil 
• γG  partial factor applied on the permanent loads applied on the wall 
• γQ  partial factor applied on the transient loads applied on the wall 
• γϕ  partial factor applied on the drained cohesion 
• γc  partial factor applied on the drained friction angle 
• γϕ,u  partial factor applied on the undrained cohesion 
• γc,u  partial factor applied on the undrained friction angle 
• γanc  partial factor applied on the anchor reaction 
• γkrz partial factor applied on the destabilizing anchor reaction 

4.3.3. Options 

Cross section may be defined by levels or by depths. 

Calculation step may be defined by the user, it means that results will be provided every calculation step value 
without no impact on the bottom level of the sheet pile calculated by Prosheet. 

Seismic calculation can be requested in this tab.  
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5. Sheet pile tab 

Sheet pile section has to be defined in this tab, its geometry and the support if necessary. If the project type is head 
wall and anchor wall, all input data must be defined for both walls. 

 

5.1. Sheet pile section 

This section is used to choose the sheet pile from ArcelorMittal catalogue. All Z and U piles are available. To choose 
a HZM/AZ combination, the type “HZM/AZ” must be selected. Then, the type of solution, the HZM sheet pile and the 
length ratio of AZ sheet pile in % must be defined.  

 

5.2. Geometry section 

This section is used to define the Z top of the sheet pile and its angle relative to the vertical (λ). 

5.3. Reduction factors section 

This section only appears if a sheet section of type U is chosen. It is used to define the βD reduction factor to be 
applied on the product of inertia (EI). 
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5.4. Earth support section 

Depending on the type of project and calculation method, one or two earth supports are available (Free or Fixed) 

• Classical method 
o Cantilever wall: the earth support is not visible 
o Other type of project: both fixed and free earth support are available 

• Eurocode method 
o Cantilever wall: the earth support is not visible 
o Anchored, propped: only free earth support is available 
o Anchor: both fixed and free earth support are available 
o Head wall and anchor wall 

 Head wall: only free earth support is available 
 Anchor wall: both fixed and free earth support are available 

5.5. Anchor section 

This section is only shown if the type of project is not a cantilever wall. It allows to define the anchor or the strut 
geometry used in the project. 

5.5.1. Anchored wall 

Input parameters to define the anchor attached to the head wall: 

• Z  anchor level where it is attached to the wall 
• α  angle of the anchor with respect to the horizontal 
• LFree  free length of the anchor 
• LEmbedded embedded length of the anchor 

 

5.5.2. Propped wall 

Input parameters to define the strut attached to the head wall:  

• Z  strut level where it is attached to the wall 
• α   angle of the strut with respect to the horizontal 
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5.5.3. Anchor wall 

Input parameters to define the anchor attached to the anchor wall:  

• Zanchor wall  anchor level where it is attached to the wall 
• α   angle of the anchor with respect to the horizontal 
• FEd   anchor reaction applied on the anchor wall 

 

5.5.4. Head wall and anchor wall 

It represents the anchor linking the head wall and the anchor wall: 

• Zhead wall  anchor level where it is attached to the head wall 
• Zanchor wall  anchor level where it is attached to the anchor wall 
• L  anchor length, it is calculated based on the distance between the two walls 
• α:   angle of the anchor, it is calculated based on the distance between the two walls 

 

6. Soil tab 

Soil tab defines the soils in the front and back of the wall. Natural ground level is defined also here for both sides. 
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6.1. Natural ground level section 

This section is used to indicate the natural ground level shape: 

• Horizontal 
o Z0  excavation level in contact with the wall 
o Δa  additional excavation (only visible with Eurocode method and only used on the front side) 

 

• Inclined 
o Z0  excavation level in contact with the wall 
o β soil inclination with respect to the horizontal 
o Δa  additional excavation (only visible with Eurocode method and only used on the front side) 

 

• Berm: only available for the front side 
o Z0 top excavation level in contact with the wall 
o Z1 bottom excavation level 
o a  width of berm at Z0 level 
o b width of berm at Z1 level 
o Δa additional excavation (only visible with Eurocode method and only used on the front side) 

 

• Embankment: it is only available for back side 
o Z0 bottom excavation level in contact with the wall 
o Z1 top excavation level 
o a width of embankment at Z0 level 
o b  width of embankment at Z1 level 
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6.2. Soil layers tab 

This section is used to define the different layers of the soil on the front and at the back of the sheet pile wall. 

It is possible to use the Kerisel-Absi tables to automatically fill the active and passive earth pressures coefficients. 
Otherwise, it is needed to enter all the characteristics manually with Custom option. 

All the soils defined in the front may be copied into the back by clicking on the  button above the back soil 
layer list. If the project type is head wall and anchor wall, the head wall soils can be copied into the anchor wall soils 

by clicking on the  button on the anchor wall part, at the top right of this section. 

6.2.1. Soil database 

Soil database window is available by clicking on “Soil database” button. 

The soils defined on the database are on the right part of the window and the soils defined in the project on the left 
side. It is possible to import soil layers into the front or back soils and export a selected soil on the front or back in the 
database. 
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7. Hydraulic tab 

Hydraulic tab is used to define the water conditions around the sheet pile wall. The conditions can be defined 
separately on the front and the back of the sheet pile wall. 

• Phreatic level: water table level must be defined in this case 
• Custom pore pressure diagram: different pressures at different levels may be defined 

 

8. Loads tab 

Loads tab allows to define all the loads applied either on the soil or on the wall. 

Wave load may be generated with a dedicated wizard.  

8.1. Loads on the soil section 

This section defines the Caquot and Boussinesq loads on the front and on the back of the sheet pile. 

• Caquot loads: 
o Side left or right 
o Z  level of the Caquot load 
o q  pressure of the Caquot load applied on the soil 
o Type permanent or transitory 

 
• Boussinesq:  

o Side left or right 
o Z  level of the Boussinesq load 
o a  distance of the load from the sheet pile 
o L  length of the Boussinesq load 
o q  pressure of the Boussinesq load applied on the soil 
o Type permanent or transitory 
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8.2. Loads on the wall section 

This section defines the linear and distributed loads on the front and on the back of the sheet pile. 

• Linear loads:  
o z  load level 
o F  linear load value applied on the wall 
o α  angle of the linear load with respect to the horizontal 
o Type permanent or transitory 

 
 

• Distributed loads:  
o z1  top level of the distributed load 
o q1  pressure at the top level (z1) 
o z2  bottom level of the distributed load  
o q2  pressure at the top level (z2) 
o α  the angle of the linear load with respect to the horizontal 
o Type permanent or transitory 

 

8.3. Wave loads section 

Wave loads are generating according Sainflou method (only valid for fully reflected standard waves from left side). 
Two diagrams are generated an applied separately only on head wall: 

• Wave pressures at crest 
• Wave pressures at through 

Required input parameters: 

• Z sea bed  sea bed level 
• T define the time between waves in second 
• H height of the wave 
• θ inclination of the wave with respect to the horizontal 

Please, refer to the part B of this manual (technical manual) for further information about this method and all 
calculation parameters. 
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9. Seismic tab 

Seismic tab is only available if the seismic calculation has been requested on the Project tab. 

Two calculation methods are proposed to take into account seismic conditions: 

• Mononobe-Okabe 
• Lancellota 

Seismic coefficients have to be defined: 

• kh horizontal coefficient 
• kv  vertical coefficient 

It’s possible to take into account inertial force of the wall in the equilibrium. 

 

9.1. Westergaard section 

Hydrodynamics effects may be taken into account using Westergaard model separately on both sides of the sheet 
pile wall. They are only applied on the head wall. 

The different soils defined in the Soil tab are recovered here with additional input parameters depending on the 
behaviour. If soil layer has been defined as “Open”, one has to define: 

• h ref top   top level of concomitant “open” layers 
• h ref bottom bottom level of concomitant “open” layers 
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10. Results tab 

Results tab is divided in 3 sections: 

• Graph 
• Tables 
• Details 

One calculation case be seen on this window at a time. The calculation case can be chosen by modifying the choices 
on the top part of the screen. 

If the Eurocode method has been chosen, ULS (ultimate limite state) and SLS (service limite state) results are 
available. 

If the project type is head wall and anchor wall, one can access results specific to each wall. 

All possible cases are: 

• Standard 
• Seismic top left  available if seismic calculation has been requested 
• Seismic top right  available if seismic calculation has been requested 
• Seismic bottom left  available if seismic calculation has been requested 
• Seismic bottom right  available if seismic calculation has been requested 
• Wave crest   available if the wave loads has been activated 
• Wave through   available if the wave loads has been activated 

10.1. Graph section 

Main numerical results are displayed on a diagram form. 
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10.2. Tables section 

All main numerical results are displayed in a table form. 

 

10.3. Details section 

Intermediate and final results as well as some checks are detailed in this section. Help images allow to understand 
the meaning of the parameters. 
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11. Scenario synthesis tab 

This tab summarizes all main information for each scenario as well results checks. 

 

12. Ergonomic features 

12.1. Export to Excel 

The current scenario can be exported to Excel by clicking File/Export current scenario to Excel. 

It will export the results, with one excel sheet for every case that has been calculated. 
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12.2. Export to Durability 

The current scenario can be exported to Durability. 

 

Screenshot of Durability export wizard 

It will export the results, with one scenario for every case that could be calculated. Only ULS results are exported, 

Depending on the type of project, the data will be exported on the head wall, the anchor wall or both of them. 

The data that are exported are: 

• The sheet pile 
• The sheet pile ztop 
• The reduction factor βD 
• The anchor (if any) 
• The zw,front and zw,back (if the hydraulic condition is defined as phreatic level) 
• The list of loads that has been calculated (z, M, V, N and e) 

12.3. Print scenarios 

Chosen scenarios can easily be printed to generate a rapport with all input data and all calculated results. 

One can choose which elements must be printed for all the selected scenarios, in particular: 

• Input data 
• Wall embedment design 
• Diagrams of main results 
• Tables of main results 
• Results details 

Print wizard is accessible from File menu: 
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